
Robust Process Engineering

Robust process engineering enables you to produce acceptable products reliably, despite 
variation in your process variables. After a process has been modeled, the Prediction 
Profiler is often used to find the best factor settings based on the given desirability of 
response values. However, matching the target responses is only part of the goal. You 
also want to minimize variation. The example in this article shows how to use DOE, the 
Prediction Profiler, and simulation capabilities in JMP to match a response target while 
minimizing response variation.

Suppose your process has factors that you can control in an experiment, but are subject to 
random variation in manufacturing. Such factors are sometimes called noise factors. The 
noise factors induce transmitted variation. Transmitted variation refers to the effect on 
the response of unavoidable variation in some factors. 

This example uses the data table shown in Figure 1. The model has two control factors, 
c1 and c2, two noise factors, n1 and n2, and all the 2nd-order interactions. You want 
to find factor settings that minimize the defect rate defined by the spec limits and the 
target. The data table shown in Figure 1, Robust Design Data.jmp, is available on the 
companion web site for this issue of JMPer Cable, found at www.jmp.com 

Figure 1  Example Design Table with Response Values

A desirable response d is centered at the target of 45, between limits of 40 and 50. The 
response has Response Limits and Spec Limits as shown in Figure 2. The Distribution 
platform will use these limits to perform a capability analysis that evaluates defect rate.

Figure 2  Column Properties for the Response Column d

JMP software helps you visualize 
and uncover data patterns that 
have an impact on research, devel-
opment, and production activities. 
JMP is used worldwide to develop 
products, reduce defects, streamline 
operations, improve quality, and 
optimize resources. Universities 
on every continent rely on JMP 
to make teaching and learning 
statistics relevant and fun.
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The Model script included with the data table runs the 
model. After running the model, use the Contour Profiler 
(Figure 3) to see a contour line of all the combinations of 
c1 and c2 values that achieve the target, given the current 
values of the noise factors.

For the target of 45 and limits of 40 and 50, the line, 
labeled d, shows the range of c1, c2 settings that hit the 
target. The unshaded area shows the factor space that is 
within specifications. In this example, c1 is arbitrarily set to 
0.75. Then c2 =  –0.319 results in a value close to the target 
of 45. Again, any point on this curve matches the target for 
d, on average.

Next, use the Simulator, found in the menu on the Contour 
Profiler title bar, to evaluate the effectiveness of these factor 

settings for the given spec limits and target.

The Simulator panel shown in Figure 3 appears with the 
settings copied from the Contour Profiler. You specify that 
the noise factors, n1 and n2, are random normal with mean 
0 and standard deviation 0.4 and add random noise to the 
response. The simulator then creates a new table with 1000 
simulated runs.

The new table appears with a script that runs the Distri-
bution platform complete with a capability analysis, as 
shown in Figure 4. You can see in the Capability Analysis 
report that the estimated defect rate (Total Outside) is 55.7 
percent. Over half the products are outside the specification 
limits. 

That is not acceptable. 

Figure 3  Contour Profiler with Simulator for Model

Figure 4  Distribution Analysis Shows 55.7% Defect Rate
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columns that JMP names Pred Formula d, Pred Formula 
d 2, and Pred Formula d 3. For clarity, rename the second 
prediction column deriv n1 and the third column deriv n2. 

Now, use the second and third formula columns to find 
the derivatives for n1 and n2. Figure 5 shows how to do 
this. Open the formula for deriv n1. Select any n1 term in 
the expression and choose the Derivative command from 
the menu above the keypad. The result is the derivative of 
the expression with respect to n1, the selected variable. Do 
the same thing in the deriv n2 formula column to get its 
derivative.

Set the Spec Limits column property for both derivative 
columns to get a capability analysis. To tell JMP that a zero 
value of the derivative is desired, set the Response Limits 
column property for the deriv n1 and deriv n2 columns, as 
shown in Figure 6.

Figure 5  Generate Derivatives Using the Column Formula Editor

Figure 6  Response Limits and Spec Limits for deriv n1 and deriv n2 Columns

In this particular example, there is a huge number of ways 
to match the target for d. Using the Contour Profiler, you 
can pick one of these ways, but it might not be the most 
robust way. That is, just matching the target for d does not 
guarantee that the resulting process is robust to variation in 
n1 and n2.

A better approach is to match a target in the flattest part of 
the noise response surface so that the noise has little effect 
on the process.

 

JMP can find these flat points using the model prediction 
formula and the derivatives of the prediction formula 
with respect to each of the noise factors. To find these 
derivatives, save the prediction formula three times, into 

The definition of flat is to have near-zero first 
derivatives.
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Now use Graph > Profiler and select the prediction formula 
column and both derivative columns as the Prediction 
Formula. Click OK and then select Maximize Desirability 
from the Profiler menu. Figure 7 shows the Profiler results. 
The solution achieves targets for both the prediction 
expression and for the two derivative expressions. Notice 
that by making the derivatives close to zero, the current 
value for the upper right two graphs is hitting the response 
curve where it is very flat, i.e. where it is most robust with 

respect to variation in the noise factors. Run the simulator 
again, as before, with the factor settings found by the 
maximum desirability, and look at the distribution of the 
simulated prediction formula for d. The distribution of this 
simulation (see Figure 8) shows that you are now nearly 
defect-free. The defect rate is 0.0004%, compared with 
55.7 % seen initially. 

Figure 7  Profiler with Maximum Desirability for Predicted Response and Noise Derivatives

Figure 8  Distribution Analysis Showing Defect Rate Near Zero

This example works well because we set up the problem 
to have a large control-factor by noise-factor interaction. 
In a real-world situation, results might not be as dramatic. 
However, this example demonstrates a technique 
that might be applicable to a need for robust process 
engineering.

Review the steps needed to apply this technique :
1 Verify that you have an experiment and model with 

noise factors and interactions between noise and 
control factors.

2. After you fit the model, save the prediction formula  
for the response factor and again for each of the 
noise factors. 

3. Use the formula editor to find derivatives with 
respect to each noise factor. That is, highlight a 
noise factor in the prediction formula and use the 
Derivative command in the formula editor.

4. Set Spec Limits and Response Limits column 
properties for the noise columns. Set zero as the 
Response Limits for the derivatives.

5. Invoke the Profiler and optimize to targets. 

6. Simulate to see if these optimized settings produce 
the desired response distribution.
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This rate is approximately 3.68 parts per million, 
very close to a Six Sigma quality level!



Drop Gills above Edibility

Drop Gills to the left of Edibility

Drop Gills below Edibility

Figure 1 Begin Interactive Tabulate

Interactive Tabulate For Nominal Variables
By Ann Lehman, SAS Institute

The Tabulate command in the Tables menu enables you to 
build tables of counts and statistics interactively. It is a drag-
and-drop arena of rows and columns. This article uses the 
MushroomDemo.jmp table from the sample data library.

When you drop a nominal variable into the drop zone for a 
tabulate row or column, the values of that variable are listed 
and the number (N) for each value is shown in the cells of 
the tabulate table. Figure 1 below shows the initial Tabulate 
platform, and the result when you drag the Edibility variable 
to the drop zone for columns. 

Once you start a table, there are still many drop zones, 
but you must select a variable and mouse around the table 
to find them. The easiest way to learn is to try dropping 
a variable in a zone and see what happens. Figure 2 shows 
the result when you drop the Gills variable above Edibility, 
below it, and to the upper left drop zone of the Tabulate 
table.

In this simple example, you might see additional drop zones 
that have redundant effects when you drop a variable on 
them. These zones come in to play when there are more 
than two variables in the Tabulate table. 

All of the variables in the data table are listed on the left 
of the Tabulate Control Panel. The summary statistics 
are listed next. For nominal variables, Tabulate counts 
the number of levels for each variable you enter into the 

Tabulate table, so only the N, % of Total, N Missing are 
meaningful. The All statistic can be used when there is both 
a column and a row variable.

Finding Total Counts and Percents
This example builds a simple Tabulate table of counts, row, 
column and grand totals, percent of grand total, and shows 
how to include row and column percents as well.
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Drag Edibility to 
the Drop zone for 
columns. There 
are 4208 edible 
mushrooms and 1916 
poison ones.

When you highlight 
a cell in the Tabulate 
table, the correspond-
ing rows highlight in 
the data table.

Statistics for 
continuous 
variables only

Figure 2  Drop Zones for a Simple Tabulate Table

Drag Edibility to 
the drop zone for 
columns



Figure 3 Include Total Counts and Percents 
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column percent is computed for a cell. For example, the  
ratio of brown edible mushrooms to total edible mush-
rooms of all colors is: 

3440 ÷ 4208 = 0.8175 or 81.75%. 

Since the denominator in this computation is the total 
edible mushrooms of all colors, dragging Color from within 
the Tabulate table (see Figure 3) to the % of Total drop zone 
recomputes each percent in that column using that column 
total (4208) as the denominator. Note that the column 
label changes to indicate which total was used to compute 
the percents (% of Total <Color>). Use Undo to remove the 
column percent.

Drag % of 
Total statistic 
to the lower 
Edibility drop 
zone.

Begin a Table: Using the Mush-
roomDemo data table, drag 
Edibility to the top of the table and 
Color to the left side, creating the 
table shown here.

Column Totals: Next, select the All statistic and drag it to 
the Color drop area to create column totals.

Row Totals: Select the All statistic again, but drag it to the 
Edibility drop zone to create row totals.

column totals    row totals

Percent of Total: Drag the % of Total statistic to the lower 
Edibility drop zone to replace the counts with percents.

Double-click 
column labels to 
edit them

To see col-
umn percent, 
drag Color to 
% of Total.

To see row percent, 
drag Edibility to 
% of Total.

Note: You can click Undo in the Tabulate Control panel 
at any time to see the table in its previous state.

Row Percent: The same logic applies to row percents. For 
example, the ratio of brown edible mushrooms to total 
brown mushrooms is:

3440 ÷ 3664 = 0.9389 or 93.89%. 

Since the denominator in this computation is the total 
number of brown mushrooms, dragging Edibility from 
within the Tabulate table (see Figure 3) to the % of Total 
drop zone recomputes each percent in that row using 
the total of that row (3664) as the denominator. The 
new column label tells you which total was used as the 
denominator for the calculation (% of Total <Edibility>).

Finding Row and Column Percents
Column Percent: There is no direct command to create 
column or row percents. Instead, first think about how a

Note: To remove any statistic from a Tabulate table, 
rignt-click on its name in the table and choose Delete.
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“JMP” Into Stats at the University of Tennessee at Knoxville
by Ramón V. León and Frank M. Guess, Department of Statistics, Operations, and Management Science and Timothy M. 

Young, Tennessee Forest Products Center, University of Tennessee at Knoxville

JMP is used extensively at the University of Tennessee (UT) 
in undergraduate introductory statistics courses, advanced 
graduate statistics courses, MBA courses, executive 
education courses, summer internships, and forest product 
work. This article describes these varied applications of 
JMP and provides links to public domain JMP tutorials and 
teaching notes used at UT.

Using JMP in Undergraduate Introductory 
Classes
At UT, undergraduate students learn JMP in introductory 
classes such as statistics for business, regression, and experi-
mental design. In fact, from fall 2004 to summer 2005, 
over 1,780 students at UT learned JMP and statistics in 
Statistics 201, an introductory Statistics for Business class 
that carries a calculus prerequisite and has been taught by 
American Statistical Association Fellow Dr. Bobby Mee. 
A prepared web site of course tutorials, developed by Dr. 
Ramón León, is available at

http://web.utk.edu/~leon/201Tutorials/
The tutorials cover everything from importing Excel files to 
creating box plots that represent earnings of hourly workers 
at a national bank.

Non-business majors also learn JMP through a general 
undergraduate statistics class. While other software 
packages, such as SAS®, S+, R, MATLAB®, and SPSS®, are 
also utilized at UT, JMP is learned, used, and understood 
by the largest numbers of students because it is the 
complementary software for the introductory statistics 
course they are required to take. The majors of these 
students range from business to engineering to arts and 
sciences.

Additionally, JMP is used in UT’s prestigious, five-year  
Alan H. Lasater Dual B.S./M.S. Program in Statistics.

The widespread use of JMP at UT is due to both the 
quickness and success with which new users can learn 
JMP’s advanced tools. These tools allow students to grow 
in statistical thinking and sophistication. For example, in 
the regression course, professors use JMP to teach students 
how to easily explore for outliers and leverage points, model 
verifications, and more.

UT also makes it easy for all students, faculty, and staff to 
access JMP. They can download a free copy based on an 
established technology fee and license agreement. Also, Dr. 
Mee, Dr. León, and others are JMP beta testers, providing 
the software developers with feedback and requests based 
on their needs.

Using JMP in Graduate Classes
UT’s MBA courses use JMP as their statistical package. 
Mee uses JMP in his graduate-level design of experiments 
and MBA courses. JMP is also useful in short courses 
taught by UT’s Center for Executive Education that leads 
to certification for Six Sigma Black Belts.

Dr. Ramón León teaches his introductory graduate 
statistical methods course, Stat 571, whose objectives 
include understanding main statistical concepts, using JMP 
to extract information from most common forms of data, 
understanding probability and sampling distributions, 
Chi-Square test for categorical data and nonparametric 
methods, and preparing to take follow-up courses in 
statistics. Dr. León’s JMP tutorials for the course are 
available at

http://web.utk.edu/~leon/stat571/jmp/

His notes for this course are integrated with JMP and are 
found at

http://web.utk.edu/~leon/stat571/Handouts.html

His tutorials for other statistics courses are available at 

http://web.utk.edu/~leon/jmp/

Many people outside UT, in industry and academia, use his 
tutorials in their own courses and for self learning. 

Using JMP in Research
Research Associate Professor Tim Young of UT’s Forest 
Product Center uses JMP and JMP scripting to automate 
statistical reports and control charts in his work with forest 
product companies in North America. He has taught 
more than 70 companies about process improvements 
in forest products. These companies vary from furniture 
manufacturing to salvaging waste wood to producing 
modern engineered wood products with high strength and 
reliability. The U.S. forest products industry contributed 
$406 billion to the economy and employed 2,140,399 
people in 2002, according to the U.S. Census Bureau 2004.

Dr. Young and Dr. Frank M. Guess presented their work as 
keynote speakers at the JMP User Conference on June 8-9, 
2005, in Cary, NC. Some of their other work was presented 
using JMP at a 2003 MIT conference by their former 
graduate research assistant (GRA), David Edward. Another 
current GRA, Weiwei Chen, presented a poster session at 
the JMP 2005 User Conference. They choose to use JMP 
during their presentation because they wanted to showcase 
JMP’s graphical and exploratory features.

http://web.utk.edu/~leon/201Tutorials/ 
http://web.utk.edu/~leon/201Tutorials/ 
http://web.utk.edu/~leon/stat571/jmp/ 
http://web.utk.edu/~leon/stat571/jmp/ 
http://web.utk.edu/~leon/stat571/Handouts.html 
http://web.utk.edu/~leon/stat571/Handouts.html 
http://web.utk.edu/~leon/jmp/ 
http://web.utk.edu/~leon/jmp/ 
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UT Teams with SAS Institute JMP Trainers
Mark Bailey, a JMP trainer from SAS Institute, gave a 
JMP scripting workshop at UT on February 4-5, 2005. 
Approximately 50 current students and alumni along with 
seven faculty members attended this two-day workshop.

Attendees’ backgrounds included electrical engineering, 
industrial engineering, material science and engineering, 
statistics, management science, finance, animal science, 
forestry, and forest products engineering. This reflects the 
incredibly strong pull JMP has across many disciplines at 
UT.

One of the class attendees, an alumnus with a local $300 
million-per-year company, used JMP scripting tools 
immediately after the class to automate statistical analyses 
in key work projects.

Furthermore, UT students on summer internships, 
especially those with design of experiments or regression 

projects, have found JMP incredibly useful. The ability of 
JMP to double check for key assumptions and model verifi-
cation are features they value. Because of the success of this 
class, UT has scheduled several upcoming workshops for its 
students, alumni, and faculty.

Conclusion
JMP is used extensively at the University of Tennessee (UT) 
in undergraduate introductory statistics courses, advanced 
graduate statistics courses, MBA courses, executive 
education courses, summer internships, and forest product 
work. We hope that our account of how we use JMP helps 
you think creatively about how you can use JMP in your 
university classrooms and research labs. We also hope that 
the links to JMP tutorials and teaching notes used at UT 
will give you ideas for incorporating JMP into your lesson 
plans.

Dr. Mary Sue Younger chats during a break with Students and Mark Bailey from SAS 

Dive in and Discover!
The Third Annual JMP User Conference will take place June 20-21 in Cary, NC. Attend 
exciting and insightful sessions on topics such as Design of Experiments, Process Improvement 
Methodologies, Issues in the Pharmaceutical Industry, and Issues in Service and Transactional 
Industries. Check out the new additions to this year’s conference program, including Special 
Events such as Roundtable discussions, a Scripting Workshop, a Genomics Discovery event, 
and exclusive new training courses. Register now to save $200 with the Early Bird discount. 

www.jmp.com/juc06

http://www.jmp.com/juc06
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Building a JMP Journal Presentation
To build a journal presentation, first create a new folder to 
hold the journal and its referenced files. Then, start a new 

journal using File > New > Journal, 
or click New Journal on the JMP 
Starter. Right-click anywhere in the 
journal window and select from the 
resulting menu, shown to the left. 

To add an item to the end of an 
existing outline item in a previously 

saved journal, right-click on the outline and choose from 
Append Item, as shown in Figure 2.

Use the following options to build a journal presentation.
Add Text Item
Enter text and select either 
paragraph or bulleted style. To 
format text, right-click on the 
text and select a formatting 
command.
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Creating a JMP Journal Presentation
By Wenjun Bao, SAS Institute

The JMP journal is a way to record a data analysis process and its results. The journal also offers a unique tool to prepare 
a presentation. The fall 2005 issue of JMPer Cable (Issue 18) gave an example of using the JMP Journal to prepare a 
presentation. This article elaborates on the Journal presentation capabilities. 

The Journal can capture almost any JMP file, as well as graphs, launch dialogs, reports, and scripts. You can also embed 
links to data tables, JSL files, HTML files, web pages, and directories. These links are especially useful when a presenter 
wants to demonstrate the dynamic relationship among JMP tables and graphics results. Figure 1 identifies many of the 
items you can have in a Journal presentation.

Figure 1 Example of Journal Presentation Items

Figure 2 Journal Presentation Commands

Add Outline Item
An outline item is a useful container for grouping items. 
You can follow an outline item with any other item in 
the journal menu. When an outline has sub-items, the 
diamond-shaped reveal button appears next to it so that you 
can expand or close sections of the presentation as needed.

Button to execute 
a script



Add URL Reference
Clicking on a URL reference in the journal presentation 
opens in your default browser, and also allows you to link 
any files (PowerPoint .ppt files, Word .doc files and Excel 
.xls files) that can be saved as html or hml files. These files 
are also opened in the browser.

Add Script Button
The journal accepts scripts either as file references (Add File 
Reference) or embedded as buttons in the journal. This 
command opens a script window where you can enter JSL 
commands and name the script. When you click the script 
button in the presentation, the script automatically runs.

If you need to manually execute an open script, select  
Edit > Run Script or use the Run 
Script button (little man) on the 
tool bar. 

By default, links are underlined, as shown previously in 
Figure 1. To change underline links to button appearance, 
right-click on the link and uncheck Underline Style.

You can add, change, rearrange, or delete any of the journal 
items at any time.

• To add an item, select it from the menu items shown 
in Figure 2 and follow the instructions. To add 
graphics, use copy and paste to place them directly 
into the journal.

• To delete an item, select the large plus selection tool 
from the tools menu or toolbar, click on the item to be 
deleted, and press the Delete key.

•   To rearrange the order of items, use the large plus 
selection tool to select and drag the item up or down 
to a new position. You can also drag an item next to 
another (drag left or right). When you drag with the 
selection tool, drop areas appear as you move around 
the journal surface.

• To delete an item with sub-items you don’t want to 
delete, use the large plus selection tool to move the 
lower level items to the side of the ones you want to 
delete. Then, delete the items you don’t want.

Add PowerPoint® Slides to the Presentation
Presenters often use PowerPoint or Keynote® slides to 
summarize material. You can access these slides from a JMP 
journal presentation using a file reference. There are several 
steps in the process to do this:

1. Create a folder to hold both the JMP journal presen-
tation and the PowerPoint presentation.

2. Prepare the JMP journal presentation as described in 
this article.

3. Open the PowerPoint presentation and save it in web 
format (.htm or .html) in the same folder.

4. In the journal presentation, add a file reference to the 
HTML version of the slides.

5. Use Set Script to generalize the file reference path.

Here is an example. Assume you have a JMP journal 
presentation like the one shown in Figure 1, and a set 
of PowerPoint slides that discuss the JMP Genomics 
components you want to show in the journal:

• Open the PowerPoint presentation and use  
File > Save As to save it in the same folder as the  
JMP journal presentation. On the save dialog,  
choose Web Page (*.htm; *html) from the Save as 
Type options, as shown in Figure 3.

Add Window Reference
Select from the list of open windows to add a link to that 
particular window. Clicking on the link in the journal 
brings that window to the front.

Add File Reference
To add a link to a file, select Add File Reference. A file 
reference in the journal opens the file in JMP with a single 
click. Some types of file references that you could use in a 
JMP journal presentation are listed here.

File Type File Extension
Table files—JMP, SAS, 
Excel, and Text

.jmp;  .sas7bdat;  .xls; 

.cvs;  .txt
JMP journal and report .jrn;  .jrp
JMP script .jsl
MS access .mdb
html files .html;  .htm

To verify that a link opens correctly, right-click on it and 
select Set Script to view or change the file path. If you open 
a script file (.jsl), the script opens in the script editor.

Add Directory of Files
This command lets you navigate to a folder and adds links 
to all its members at once in the journal. 

Add All Open Files
This command adds an outline item for each open JMP 
data table. Each outline item includes links to that table 
and all of its open analysis reports.
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Note: This command is resursive, so files in all the 
folders within folders are also added to the outline 
item.



Figure 3  Save JMP and PowerPoint Presentations Together

• In the JMP journal, right-click the outline item where 
you want to add the PowerPoint presentation and 
select Append Item > Add File Reference (Figure 4).

Figure 4  Add File Reference to PowerPoint Presentation

 the PowerPoint presentation and select Set Script.
This opens a script window with a script that includes 
the path, as shown in Figure 6. Change the reference 
path to include only the file name within quotes. This 
generalized link works on any computer, as long as 
both the journal and the slides that were saved as a web 
page are in the same folder.

Figure 5  Select the Master PowerPoint Slide 

Figure 6  Generalize the File Reference Path

This article demonstrated that a JMP journal offers a 
unique way of presenting a variety of file types, including 
data tables, graphics, websites and any files that can be 
saved as html or htm files such as those from PowerPoint, 
Word, Keynote, and Excel files. 

• Choose HTML Files in the Files of type list and select 
the master PowerPoint slide, as shown in Figure 5.

• Finally, generalize the presentation so that you can use 
it on any machine. Right-click the reference to 

What is JMP Genomics?
JMP Genomics is a powerful desktop software system for statistical analysis of genetic marker, microarray, 
and spectral (proteomics and metabalomics) data. JMP Genomics uses JMP as a powerful and dynamic data 
visualization and statistical analysis desktop client to SAS. New genomics dialogs employ the JMP Scripting 
Language (JSL) to directly launch SAS macro programs in the background. This enables access to full power of 
both SAS and JMP data processing capabilities.

Three separate products in the software system cover the three main types of high-throughput data arising from the 
central dogma of molecular biology: DNARRNARProteins.

 •   JMP Genetics—for genetic marker (SNP) data, case-control or pedigree experiments

 •   JMP Microarray—for gene expression or RNA transcript abundance data 

 •   JMP Proteomics—for spectral (mass spec or NMR) data on peptides or metabolites

Each product includes the necessary SAS products plus a fully functional version of JMP 6 with added genomics 
capabilities accessed through a JMP Genomics menu.
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